Graphing Tutorial using Excel
There’s lots of graphing software out there, some make graphs prettier/easier than others.  Luckily, Excel makes pretty decent graphs, easily.  So, even though you’re running all of your statistics in JMP, you’ll also want to put all the data into an Excel spreadsheet so that you can make pretty graphs.  I’ll go through the steps assuming that you’ve never used Excel, so if you have, you may want to skip ahead a few steps.

Getting your file into Excel:

Download the class data spreadsheet.  When you click on the attachment, you may be asked what program you should open it with, if you have the option, choose Microsoft Excel.  If you’re not given the option, download it to your desktop, open it, and if it’s not already in Excel, go to the Save As menu and save it in the Excel format, the file name should end with xls or xlsx (for the newer Excel version).  Open the spreadsheet.

Making sure your data are in the right format:

Any data that Becca sends out will probably be correctly organized.  However, if you type data into Excel yourself, it’s better if it’s arranged in a certain way (you’ll find this is true for most statistical & graphing software, although the arrangement does differ between programs).  Basically, you want to arrange your data into columns, meaning that you want to have your heading, such as TEMPERATURE, in the first cell and have all your measurements going down below that (Table 1 – THIS IS MADE UP DATA).

	Temperature under log
	# isopods 

	15
	20

	15.5
	23

	14
	16

	14.25
	18

	15.6
	23

	16
	26


Table 1: GOOD way to arrange data

	Temperature under log
	15
	15.5
	14
	14.25
	15.6
	16

	# isopods 
	20
	23
	16
	18
	23
	26


Table 2: BAD way to arrange data for most software

Note: A little shortcut – if your data is arranged like Table 2, you can select each row, copy it, go to ‘paste special’ under the ‘Edit’ menu, and select ‘Transpose’ – that will put the data into a column so that you don’t have to retype it all.

How do I know what kind of graph to make with my data?
Probably the most common types of graphs you’ll be making are ‘Scatterplots’ or ‘Column’ graphs.  Both are very useful.  

Scatterplots are good when you have two variables that might be correlated or depend on one another, and both variables should be continuous.  This is the kind of graph you would make to display something that you’ve used a linear regression to analyze.  

Column graphs are good when you have 1 categorical variable and 1 continuous variable.  These graphs are often good to display data you’ve used t-tests or ANOVAs to analyze.

You always want to think about the SIMPLEST and CLEAREST way to present your data. There’s almost never a reason why you’d want to use some of the graphs offered in Excel, such as the 3D graphs or the ones with crazy colors. They only detract from understanding what’s going on. Avoid these! A note on color, you really only want to use colors if it helps to clarify your data, otherwise stick with black & white.

Making a Scatterplot
1. Click on the ‘Insert’ menu, then ‘Chart’, or click on the graphing icon in the toolbar (looks like a little blue, yellow, and red column graph).

2. A window will pop up.  Your first step is to pick the type of graph you want to use.  In this case click on ‘XY Scatter’.  Then there will be five options for the type of scatterplot you can use.  For now, use the one that just has dots, with no lines.  Click next.

3. There are two tabs in this next step.  One is ‘Data Range’ the other is ‘Series’.  I prefer using the ‘Series’ window because it allows more control over what you’re inputting.  So click on the ‘Series’ tab.  

4. Now it is asking for the data.  Click ‘Add’.  Put your cursor in the ‘Name’ box and then click on the cell that contains the heading for your column of data, or just type in the name you want to give it (you can always change this later).  The title you want to put here is the one for your DEPENDENT (Y-AXIS) data.  In the example above, this would be # Isopods.

5. Now click on the ‘x-values’ box and then highlight the data you want to use as your INDEPENDENT variable.  In this case, Temperature.

6. Click on the ‘y-values’ box and highlight the data you want to use as your DEPENDENT data.  In this case, # Isopods.  

7. ADVANCED STEP: If you had several things that you wanted to put in the same graph, for example if you wanted to look at the # Isopods, # Beetles, and # Salamanders as they relate to this same set of Temperature data, you would do that at this time.  To add another column of DEPENDENT data (such as # Beetles), click on ‘Add’ and repeat steps 4-6 using your # Beetles column for ‘y-values’ and the same Temperature column for ‘x-values’.  By doing this, you’ll have a graph where you can visually compare the abundance of Isopods, Beetles, and Salamanders as related to Temperature.  If you change your mind & just want one set of data on this graph, you can always highlight the data you want to remove and click ‘Remove’.  Click ‘Next’

8. Here’s where you make your graph pretty:

a. ‘Titles’ Tab: You MUST put labels on your graph!!!  You do not need a title on your graph (ignore that on the graphs shown here) because you should put a caption under it, and it would only be repetitive. You MUST put x and y-axis labels, INCLUDING UNITS.  Units usually follow the labels in parentheses.  For example: y-axis: Number of Isopods and x-axis: Temperature (degrees C).

b. ‘Axes’ Tab: You probably won’t have to change anything here until you get into more advanced graphs, so don’t worry about it as long as your values for your axes show up.  If not, try clicking in these boxes.

c. ‘Gridlines’ Tab: Very important for the style of your graph!  Almost all graphs in journals DO NOT have gridlines, so that is how you should make your graphs.  If any of the boxes on this tab are checked, uncheck them.

d. ‘Legend’ Tab: If you only have 2 factors in your graph, such as # Isopods & Temperature, the legend is unnecessary, so where the box ‘Show legend’ is checked, click on it to uncheck it.  If you have something like, # Isopods, # Beetles, # Salamanders, and Temperature, you DO need the legend, and you can move it around later if you like.

e. ‘Data labels’ Tab: These boxes, if checked, will put the actual number for each value right next to the data point.  Totally unnecessary & messy, generally you won’t do this for a scatterplot.

f. Click Next

9. Here you’re being asked where in your file you want your graph – Excel will create another sheet & put it in there or you can put it right in the sheet your working on, this is what I usually do b/c its nice to be able to see the data & the graph at the same time.  
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Figure 1: Relationship between Temperature (degrees C) and the abundance of Isopods found under logs in Pacific Spirit Park, Vancouver.  Ugly version.

10. Now here’s your second chance to make your graph even prettier!!  

a. First, get rid of the grey background – yuk.  Double click on the grey area.  The ‘Format Plot Area’ window will pop up.  Here you can change the color of your background and of the border around that area.  You want to click ‘None’ for both.

b. Then you want to make your graph so that the data points are spread out.  Double click on the x-axis, the ‘Format Axis’ window will pop up w/ several Tabs.  You can mess around with these just to see what they do, but most importantly, you want to change your ‘Scale’ – click on that Tab.  You can either eyeball your data points or look at the actual data to figure out what you should make your scale.  For the above data, I would suggest changing the ‘minimum’ to 12, and ‘maximum’ to 17.  You want to leave a little room at each end so that you can actually see all the data points.  Similarly, you can change the scale for your y-axis by double clicking on the y-axis.  ADVANCED STEP: You can also change your axes to a Log scale in the ‘Scale’ menu if appropriate for your data.

c. Next, you want to adjust the color of your data points. If you’re putting this graph into a paper/report, you want to make the whole graph in black & white or grayscale. If you’re putting this graph into a PowerPoint presentation, you’ll usually want to use colors.  Either way, you want to make sure your colors/shades are different from each other (if you have several variables), and you want to make sure they are very visible against your background. You also want to avoid colors that are difficult to tell apart by colorblind folks, for example – red and green look the same to a colorblind person. You can also change the size & shape of your data points, and add or remove a shadow. Double click on any one of the data points that are on the graph. This will bring up the ‘Format Data Series’ window. You’ll primarily be using the ‘Patterns’ Tab. Here you should change the color, size, or shape of your points.  
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Figure 2: Relationship between temperature (degrees C) and the abundance of Isopods found under logs in Pacific Spirit Park, Vancouver.  Pretty version.

d. BROWNIE POINTS: If you are doing a linear regression on this data as your statistic, it would be nice to add a ‘trendline’ to your graph to show how well the data points fit a line.  Right click on one of the data points, a drop down menu will appear, click on ‘add trendline’.  There are 2 Tabs – ‘Type’ and ‘Options’.  For most of this class, you’ll only need to deal with a ‘Simple’ line, click on that (you can also change the color of this line if you have several sets of data on one graph).  Under ‘Options’ you can display the equation of this line and/or the R2 value on the graph itself.  You would not display this information on the graph in a paper, but you might include it in the caption below.  
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Figure 3: Scatterplot and best-fit trend line depicting 

the relationship between temperature (degrees C) and 

the abundance of isopods found under logs in Pacific 

Spirit Park, Vancouver (y = 5.35x – 59.46, R2 = 0.96).  

Final version w/ good caption.

Making a Column Graph

Much of this will be the same as making a Scatterplot.  Let’s use the example of have multiple variables (Isopods, Beetles, & Salamanders).  Usually in a Column graph, you want to graph the means/averages of your data.  So your data may look like this (these are calculated means of your raw data):

	Mean

	Month
	# Isopods
	# Beetles
	# Salamanders

	January
	5
	3
	0.25

	February
	6.5
	4.5
	0.75

	March
	7.5
	5.5
	0.75

	April
	9
	7
	1

	May
	10
	7.5
	1.5

	June
	16.75
	12.75
	1.5

	July
	19.25
	15.25
	2.25


Table 3: Data for Column graphs, using multiple variables.

A. Again, click on the graphing icon in the toolbar.  This time select ‘Column’, and the one you’ll usually use is the top left version of a column graph.  Click ‘Next’.

B. Again, click on the ‘Series’ tab.  

i. Click ‘Add’.  

ii. Again, for title, click in the box, then highlight the cell of the title of your first column of DEPENDENT data (#Isopods).  

iii. Then click in the ‘Values’ box.  This is where you’ll put your first set of DEPENDENT data (#Isopods).  So highlight that whole column of data.  

iv. Then click in the ‘Category (X) axis labels’ and highlight the column where your INDEPENDENT data is (Month).  Excel is giving you a clue here – you want to use these graphs when your independent data is categorical.  

C. To add your other columns of data in, click on ‘Add’ and repeat steps ii & iii above with #Beetles and then again with #Salamanders.  Click ‘Next’ when finished adding all your data.

D. The next window is identical to the one you’d get for a Scatterplot graph.  Follow steps 8a-f (on page 2).  Note: be sure to make your y-axis label/title appropriate for all the kinds of data you have in the graph.  And if you have something like an average, you MUST put that in your axis label and caption.

E. You again have another chance to make your graph pretty.  You can do this using the same techniques as the Scatterplot – see steps 10a-c.  

i. Get rid of the grey background & border.  

ii. Change the scale of the y-axis if necessary.

iii. Change the colors of the bars if necessary (you can use shading & patterns too by clicking on ‘Fill Effects’ in the ‘Patterns’ tab – that’s how I did the ones below).

iv. Change the thickness/closeness of the bars using the ‘Options’ Tab, ‘Gap Width’.

v. Change the font/size of text if necessary.

vi. Move the legend if necessary (just drag it).
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Figure 4: Average abundance of isopods, beetles, and salamanders found under logs in Pacific Spirit Park in 2007. 

F. To add error bars to your bars, you’d click on the ‘Y Error Bars’ Tab.  Most of the time you’ll want to use the ‘Both’ option for your bars.  You can use Standard Deviation, Standard Error, or calculate your own Error.  The latter is the best option.  To calculate the standard error of your means in Excel:

i. Go back to your data and insert a new blank column after each of your columns of data (after Isopods, after Beetles, after Salamanders).

ii. To figure out the Standard Error (SE) for the mean of # Isopods in January (= 5, outlined in pink), first click in the cell just to the right (pink shaded box), then type this formula (this isn’t a pre-set Excel formula, so don’t bother looking for it in Excel, you have to type it in yourself): =STDEV(#)/SQRT(n).  In the spot where there is a # sign, you need to highlight the pink cells on the left.  Where there’s an ‘n’ you should type in the number of data points you have, in this case, 4.  Repeat for every mean for every month.  See that the orange SE uses the data in the orange cells on the left, and so on.  You need to use the correct data for each different calculation.  Repeat for each critter (#Beetles & #Salamanders).  This is a tedious process.

	Raw Data
	
	
	Mean
	SE
	Mean
	SE
	Mean
	SE

	Month
	# Iso
	# B
	# Sal
	
	Month
	# Iso
	# Iso
	# B
	# B
	# Sal
	# Sal

	January
	5
	3
	0
	
	January
	5
	0.41
	3
	
	0.25
	

	January
	6
	4
	0
	
	February
	6.5
	0.65
	4.5
	
	0.75
	

	January
	4
	2
	0
	
	March
	7.5
	0.65
	5.5
	
	0.75
	

	January
	5
	3
	1
	
	April
	9
	0.41
	7
	
	1
	

	February
	6
	4
	0
	
	May
	10
	0.91
	7.5
	
	1.5
	

	February
	8
	6
	0
	
	June
	16.75
	0.85
	12.75
	
	1.5
	

	February
	5
	3
	1
	
	July
	19.25
	1.11
	15.25
	
	2.25
	

	February
	7
	5
	2
	
	
	
	
	
	
	
	

	March
	7
	5
	0
	
	
	
	
	
	
	
	

	March
	6
	4
	2
	
	
	
	
	
	
	
	

	March
	8
	6
	1
	
	
	
	
	
	
	
	

	March
	9
	7
	0
	
	
	
	
	
	
	
	

	April
	9
	7
	2
	
	
	
	
	
	
	
	

	April
	9
	7
	1
	
	
	
	
	
	
	
	

	April
	8
	6
	0
	
	
	
	
	
	
	
	

	April
	10
	8
	1
	
	
	
	
	
	
	
	

	May
	11
	9
	3
	
	
	
	
	
	
	
	

	May
	9
	7
	0
	
	
	
	
	
	
	
	

	May
	8
	6
	2
	
	
	
	
	
	
	
	

	May
	12
	8
	1
	
	
	
	
	
	
	
	

	June
	15
	11
	1
	
	
	
	
	
	
	
	

	June
	19
	15
	2
	
	
	
	
	
	
	
	

	June
	16
	12
	0
	
	
	
	
	
	
	
	

	June
	17
	13
	3
	
	
	
	
	
	
	
	

	July
	18
	14
	4
	
	
	
	
	
	
	
	

	July
	20
	16
	0
	
	
	
	
	
	
	
	

	July
	17
	13
	3
	
	
	
	
	
	
	
	

	July
	22
	18
	2
	
	
	
	
	
	
	
	


Table 4: How to calculate Standard Error of the Mean in Excel.

iii. Now you are ready to use your calculated SE values in your graph.  On your graph, double click on the bar for your first variable.  Select the ‘Y Error Bars’ Tab.  Click ‘Both’.  Click in the text box next to ‘Custom +’.  Then highlight your first set of SE values – the whole column of SE # Isopods.  Then click on the ‘Custom –‘ box and repeat.  Click on the bars for your other variables and repeat, using the columns that correspond to the correct variable.

iv. Once you’ve done this, make sure you change your y-axis label and caption to explain what your error bars represent.  Also be sure to include how many data points are represented (your n), see below.  

You can then select, copy, and paste any of these graphs into a Microsoft Word document (as I’ve done in this tutorial), so that the graph/table appears near the text of your report (much nicer then putting them all at the end).  Once they’re in your Word document, you can also change the size of the graph, and center it in the page, or keep it over to one side.
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Figure 5: Average abundance of isopods, beetles, and salamanders found under logs in Pacific Spirit Park in 2007 +/- Standard Error.  N = 4 for each bar. 

** A note on types of graphs:  In Excel you have the option of making 3D type graphs – DO NOT USE THESE unless you think it’s absolutely necessary.  Stylistically, you want your report to be very SIMPLE and CLEAR to read, there should be no extra bells & whistles.

** A note on Figure/Table captions.  Please use the examples in this Tutorial as a guideline for how you should write your captions.  Any Tables should be labeled as a Table, any graphs, photos, drawings, etc (anything that is not a table) should be labeled as a Figure.  They should be numbered according to the order that they appear in your report, and Tables and Figures should each follow their own numbering system.  
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